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Other forecasting programs

· Expert Pools Predictor
· Will's Football Yearbook

Copyright of Fixtures

Context sensitive help is available.    Brief tips can be obtained by clicking on Help 
options on the menu bars.    For more detailed help just press the F1 key on your 
keyboard.

Frequently Asked Questions



Overview

This program is a public domain demonstration version of Dr. Fox's Football Annual.    It 
may be freely copied and distributed.

It lets you store and analyse football results.    The demonstration version has all the 
features of the full version except that it only covers the FA Carling Premiership.

The full version covers the following competitions:

The Football Association Carling Premiership
The Nationwide Football League; Divisions 1 to 3
Vauxhall Conference
Dr Martens League Premier Division
Unibond League Premier Division
ICIS Football League Premier Division
The Bell's Scottish Football League; Premier, First, Second and Third Divisions

and may be obtained by sending your name and address along with a cheque or PO for
£8, made payable to Dr. Fox to:

Dr. Fox's Football Annual, Dept D., PO Box HP54, Leeds, LS6 2XS

It is very user friendly, making full use of the pull down menus, command buttons, alert 
boxes, scroll bars, etc.

It is supplied with all of the last seven seasons' results, and all of the current season's 
fixtures.    It is also supplied with all the season's results up to the date of dispatch.    
This means that all you have to do each week is enter the results and sort out any 
rearranged matches.

The program allows many different ways of analysing the results.

It can produce a statistical analysis of any team's performance, including Consecutive 
Wins, Draws, Losses and Score Draws.    Runs of games without a Win, Draw, Loss or 
Score Draw.    Best and Worst results.    Graphs of league position history and goals for 
and against.    Latest results, current league record and distribution of results.

It lets you analyse any fixture, by displaying a statistical analysis of both teams making 
up the fixture.    The fixtures can be selected by date, teams or the result.

It can display any team's matches in chronological or opponent order.    This lets you 
find the date and result of any match very easily.

It can display league tables for any selected date.



It lets you see the distribution of each type of result in any division.    This lets you spot 
the divisions most likely to produce more home wins, away wins or draws.

It can make forecasts of results by using a user defined formula based on previous 
results.    It lets you see how good your chosen prediction formula is for any particular 
date.    It displays lists of most likely draws, home wins and away wins based on the 
formula, along with the actual result, if known.

It can cope with teams being disqualified or having points deducted from their league 
record.    Finally, there is a Team Search facility which lets you find out which division 
any chosen team is playing in during the seasons covered.



Requirements and Installation

This program requires an IBM compatible computer running Windows 3.0 and MS DOS 
3.1 or later, with an EGA or higher monitor, a hard disk, a mouse and a 3½" disk drive.

To install Dr. Foxs Football Annual Demo

Windows 3.0 Installation

put the Dr. Fox disk into your 3½" disk drive
Go into Windows
Click on the File menu bar option in Program Manager
Choose the Run... option from the pull down menu
Type a:\setup.exe in the dialog box
Click on OK

Windows 95 Installation

put the Dr. Fox disk into your 3½" disk drive
Click on the Start menu bar option
Choose the Run... option from the menu
Type a:\setup.exe in the dialog box
Click on OK

These commands will copy all the relevant files from the 3½" disk onto your hard disk.    
To run the program double click on the Football Annual Demo icon in the new Dr. Foxs 
Football Annual Demo Window.



WHAT'S NEW FOR 1997

Analyse Team/Fixture/Results

I have made the first page of statistics on sequences into a set of bar graphs.    This 
should make it easier to see how long current sequences of results are, and how they 
compare with the best sequence so far during the season.

More Copy Options Added

I have added Copy options to allow Tables, Results, Forecasts, Match Lists, Division 
Statistics, Date Statistics, Team Searches and Lucky Dip selections to be copied to the 
clipboard for pasting into other applications such as spreadsheets or word processors.

Toolbar

I have added a toolbar to many of the pages to allow some common options to be 
selected via a single mouse click.    These include Print, Save to Disk, Copy to 
Clipboard, Select Another Date, Select Another Club and Help options.

Cup Games

The full version will probably cover cup games for the FA Cup, Coca Cola Cup, Scottish 
FA Cup and FA Trophy.



Introduction

The program uses a standard Microsoft Windows interface.    The easiest way to use the
program is via the mouse, making selections by clicking on menus, buttons, scroll bars 
and dialog boxes.

If you want to activate pull down menus without using the mouse then press the Alt key 
and then choose the appropriate highlighted key to choose your menu selection.    Arrow
keys can then be used to move through the pull down menus, when you want to select 
an option press the Return key.

The Tab key often lets you move around between buttons, boxes and scroll bars on the 
screens.

Where appropriate the following keyboard short cuts can also be used: Ctrl P - prints 
the current page, Ctrl S - saves the current page to a disk file and Ctrl C - copies the 
current page to the clipboard.

On many pages there is also a toolbar, allowing common options to be selected using a 
single click with the mouse.

The program starts by displaying important copyright information. After reading this 
press the return key or click on the OK button.    The program now reads in all of the 
data about all of the teams for the current season.    When the data has been read the 
Top Screen is displayed and you are allowed to make selections from the menu bar 
along the top of the screen.

The Top Screen

The File Menu
Exit

The Enter/Amend Menu
Fixtures
Results

The Display Menu
Matches
Tables

The Analyse Menu
Team
Fixture
Results
Division
Date
Forecasts

The Goodies Menu
Team Search



Misdemeanors
Set Forecast Formula
Use Nicknames

The Calendar Screen



The Calendar Screen

The calendar screen is used by many of the program's menu options and makes 
selecting an appropriate date very easy.    (For an example choose the Display Tables 
option)

What is displayed on the calendar screen

A calendar for the current month is displayed within its own window, the days of the 
week being displayed across the top row.    Each day in the month has its own box and if
there are any matches on any day they are noted within that day's box by a 0 symbol.

Selecting a different month

More months within the current season can be displayed by clicking either side of the 
vertical slider or clicking on the scroll arrows down the right hand edge of the window.

Selecting a date

A nominated date for selection is displayed below the calendar.    To nominate another 
date click on the chosen day box using the mouse.    To choose a nominated date either 
double click on your chosen day box, or click on the OK box.

It is also possible to move around the day boxes by using the Tab key.

Selecting dates in another season

A different season can be selected by using the Season option on the menu bar.



The File Menu

The File Menu is used to exit from the program.    The only option under the File menu 
is Exit.



The Enter/Amend Menu

There are two options under the Enter/Amend menu; Results and Fixtures.

To Enter or Amend Results choose the Results option.    Similarly to Enter or Amend 
Fixtures choose the Fixtures option.    (What a surprise)

As all the season's fixtures are already supplied with the program, you should only have
to use the Fixtures option to sort out re-arranged or postponed matches.



Results

On selecting the Results option you are asked to select the date of the matches from 
the calendar screen.    Once a date has been selected, you are presented with a list of 
the fixtures on that date.

Entering Results

The current fixture whose result is to be entered or amended is highlighted.

To enter a team's score use the numeric keypad to enter the digits followed by a press 
of the Enter key, e.g. to enter a score of 2-1, press 2 Enter 1 Enter.

As each result is entered the current fixture moves down to the next match on the 
displayed list.

Tip: Check you have the Num Lock activated (Press your Num Lock Key until the Num 
Lock light comes on) if you want to use your numeric keypad to enter the numbers.

The Delete key can be used to delete the current result.

Moving between matches

To jump straight to a required match you can click on the appropriate results slot with 
the mouse pointer.    You can also move around the matches by using the up and down 
arrow keys.

Special results

Any postponed matches can be entered by pressing the P key. As it is now quite 
common for some matches on Saturdays to be rearranged to be played on Sundays in 
order to be seen on television, I have added the option of using the S key to shift a 
match forward by one day.

Entering results for another date and finishing

When you have finished entering results on the chosen date, either select another date 
using the Another Date option on the Options menu or the Finished option to exit from
the original Enter/Amend Results option and return to the top screen.    Every time you 
do this the results are automatically saved to your hard disk.

Printing and Saving Results

The results can be sent to a printer by using the Print Page option or saved to a file by 
using the Save As option.    The entire season's results can also be printed or saved by 
choosing the appropriate option on the Options menu.



Menu bar and toolbar options are available for printing saving and copying results.

You DO NOT have to use the menu bar or toolbar Save options to ensure that the 
results you have just entered are stored on your hard disk for use next time you use the 
program. This saving action takes place automatically each time you leave the Enter 
Results page. The Save options on the menu bar and toolbar are for producing a text 
file on your disk that contains a list of the results you have entered which you can then 
incorporate into other documents with your favourite word processing package.



Fixtures

If you choose the Enter/Amend Fixtures option you are given the choice of defining the
fixture by its date or its teams.    If you have a list of fixtures on a given date it is easiest 
to use the date option, whereas if you have a list of fixtures of a given team it is easiest 
to use the teams option.



Entering fixtures with the date option

If you choose the date option you have to select a date via the calendar.    You are then 
given a list of fixtures already set for the chosen date, along with a Team menu to allow 
you to set additional fixtures from the remaining teams without a match on the chosen 
date.

Setting fixtures

To set a fixture just click on each team name as appropriate.

Deleting fixtures

The Backspace key can be used to delete teams from the fixture list one by one.

Clicking on a fixture will also delete that match.

Setting fixtures on another date and finishing

When all the required fixtures have been set you may either select another date via the 
Another Date option or return to the top screen via the Finished option on the Options
menu.



Entering fixtures with the teams option

If you choose the teams option you are first asked to choose the Home team.    A list of 
teams in the current competition and season is presented.    If you want teams in an 
alternative season or competition you should use the Season or Competition menu 
options.    Once a home team has been selected you are presented with a list of all 
possible away opponents along with the current list of dates that the matches will take 
place.

Setting a fixture date

The current fixture date to be amended is highlighted.    You can set the day and month 
of the current fixture via a DAY and MONTH menu in the bottom half of the screen.

Deleting a fixture

The current fixture date can be deleted by using the Delete key.

Selecting a fixture to set

As each date is entered the current fixture moves down the opponent list.    A new 
current fixture can also be selected by clicking on a date slot with the mouse.

Setting fixtures for another home team and finishing

When all the required fixtures for the home team have been set you may either select 
another team via the Another Team option or return to the top screen via the Finished 
option on the Options menu.



The Display Menu

There are two options available under the Display menu, they are the Tables option and
the Matches option.    The Tables option is used to display league tables, the Matches 
option to display fixture lists.



Tables

The Display Tables option allows you to display the League Table on any chosen date. 
The date is selected first, via the calendar.    The League Table is then displayed. 

What is displayed

A standard league table is displayed.    This gives the number of games played (P) the 
number of wins (W), draws(D) and losses(L), goals scored for (F), and goals scored 
against (A), and the total number of points gained (PTS).    Additional columns give any 
points deducted (PD) and either the goal difference (GD) or goals scored (GS) 
depending on how positions are determined for teams on level points.

By default both the home and away components are shown.    If you prefer you can just 
display the totals of the home and away components by selecting the appropriate option
from the menu bar.

Printing, saving and copying the table

You also have the option of printing the currently displayed league table, sending a copy
of it to a disk file or copying it to the clipboard, by selecting appropriate menu bar or 
toolbar options.



Matches

With this option you can display the entire fixture list of any selected team, sorted by 
date or opposition.    The date option is useful when you want to find out who a given 
team is playing on any date, e.g. who have Manchester Utd got this weekend.    The 
opposition option can be used to easily discover when a given team is playing against 
any other team, e.g. when are Manchester Utd playing Leeds Utd away from home.

Selecting a team

On selecting this option you first have to select the team whose fixture list you want to 
display.    This is done via the standard team selection menu.    A list of teams is 
displayed, you have to select one using the mouse.    To nominate a team for selection 
you should click on the team name.    To select a nominated team you should either 
double click on the team name or click on the OK box next to the name of the 
nominated team.

The team list for a different season can be selected by using the Season menu on the 
menu bar.    

Sorting fixtures by date or opponent

Once a team has been selected you are asked whether you would like to have that 
team's fixture list displayed in time or opposition order.    Once you have decided, that 
team's fixture list is displayed.

What is displayed on the match list

The first column gives the date of the fixture, including the day of the week.    The next 
column gives the name of each opposing team.    The next column gives the venue of 
the match.    The final column gives the result of the match if it is known.    To aid 
recognition, home matches are coloured red, while away matches are coloured blue.    
The vertical sliders and scroll arrows down the right hand edge of the screen should be 
used to display all the pages of the fixture lists.    

Printing, saving and copying the match list

Menu bar and toolbar options are available for resorting the fixture list, sending the 
fixture list to a printer or a disk file or copying it to the clipboard.

Selecting another team or finishing

The Options menu gives you the option of selecting another team, or quitting from the 
Display Matches option and returning to the top screen.



The Analyse Menu

Six options are available under the Analyse menu option.

Analyse Team
Analyse Fixture
Analyse Results
Analyse Date
Analyse Division
Analyse Forecasts



Team

This option produces a statistical analysis of any chosen team.    

What is displayed

This comes on five pages. On the first page there are details about sequences of 
results, e.g. how many away games the chosen team has gone without a loss, or how 
many consecutive home wins they have had.    Both the current sequences and the best
sequences so far during the season are given.    These are displayed graphically for 
each type of result.    Each result type (Win (W), Draw (D), Loss (L) or Score Draw (S)) 
is represented by a bar.    The height of the bar corresponds to the best sequence so far,
the amount the bar is filled shows how many games make up the current sequence.    
The team's best and worst results are also displayed.    These are defined by the size of 
the winning or losing margin and then by the number of goals scored or conceded 
respectively.    So for best results a 5-2 win is better than a 5-3 win as the winning 
margin is greater and it is also better than a 3-0 win as more goals were scored.

More graphs are displayed on the next two pages.    The first is a graph of the league 
position of the team as the season progresses.    Each of the team's matches is 
indicated by a diamond symbol.    Clicking on a diamond symbol will produce a box 
giving details of the match.

The second is a pair of graphs showing goals for and against throughout the season.    
Clicking on a bar produces a box giving details of the match.    Data on average goals 
for and against are also displayed.

The team's recent form is displayed on the fourth page.    The most recent six matches 
are shown along with the team's league table entry.    The final page shows the 
distribution of different results for the team, so you can find out if Arsenal really do have 
more 0-0 draws than anyone else.

It is also possible to display a statistical analysis of a match, where the statistics for both
teams are displayed for comparison.    The match can be chosen according to the date 
or teams of the fixture or by the result of the match.

Printing, saving and copying the analysis

Options are available on the menu bar and toolbar for printing the current page, saving 
it to a file on your disk or copying it to the clipboard.



Fixture

The Analyse Fixture option is similar to the Analyse Team option except that a 
statistical analysis of both teams making up a fixture are displayed.    To aid recognition, 
the home team's statistics are shown in red and the away team's in blue.    The statistics
only refer to the situation prior to the match taking place.    A forecast of the result of the 
match is also displayed.

For the graphs, clicking on position symbols or goals bars with the left mouse button 
produces a box giving details of the home team's match, clicking with the right mouse 
button produces the away team's match details.



Results

This option lets you find and analyse results of a chosen score in any division, e.g. all 
the 1-1 draws.    On choosing this option you are given a set of available results to 
choose from. Matches where either side scores more than six goals can be selected by 
choosing the Other button.    Clicking on one of the results produces a list of all the 
matches with the chosen score.    You now double click on the match you want to 
analyse to select it.



Division

This option displays the distribution of each type of result up to a selected date.

What is displayed

Once a date has been selected via the calendar, the statistics for the division are 
displayed.

This includes:

the number of home wins, away wins and draws
the percentage of home wins, away wins and draws
the total number of matches to be played
the total number of matches that have been played so far
the percentage of the total of the matches that have been played so far
the number of matches that still need to be arranged
the number of home goals and away goals
the average number of home goals and away goals
the total number of goals scored
the average number of goals scored per match
the number of home goals minus the number of away goals
the average of the number of home goals minus the number of away goals

The distribution of different scores are also displayed, so you can see how many 
matches resulted in scores of 1-0, 2-1, 1-1, etc.    Two tables are displayed, the first 
gives the number of games with the given score, the second gives the percentage.    For
both tables the home score is down the table, the away score across the table.

Printing, Saving and Copying the division statistics

Options are available on the menu bar and toolbar for printing the current page, saving 
it to a file on your disk or copying it to the clipboard.



Date

The Analyse Date option allows you to see how many of each type of result have 
occurred on any given date and how well the user defined formula predicted the results. 
This is probably the best page to use when choosing your numbers on your pools 
coupon.    

What is displayed

On selecting a date via the calendar four pages of information can be displayed.

On the first page the number of home wins, away wins and draws on that date are 
shown as are the number of forecast results of each type.    If the results of the matches 
are known on the selected date, the number of correct forecasts of each type are also 
shown.

Pages two to four show lists of the most likely draws, home wins and away wins 
respectively, as calculated using the user defined formula.    Once again, if the results of 
the matches are known then they are also displayed.

For picking draws on your pools coupon you can either select your matches from the list
of most likely draws or exclude the most likely home and away wins and make your 
selection from the remaining matches. You can use the Lucky Dip option to make a 
random selection from those matches remaining.

When the results of matches are known or when analysing previous season's results, 
these pages are also very useful when fine tuning the prediction formula you use. You 
can easily see the effect of changing the values you have chosen in your prediction 
formula on the accuracy and distribution of the predictions.

Printing, saving and copying the date statistics

All four pages can be printed, saved to a file or copied to the clipboard by using the 
appropriate option on the Options menu or the toolbar.



Forecasts

The Analyse Forecasts option is used to display the forecasts of results produced by the
user defined Forecasts Formula.

What is displayed

Once you have selected a date via the calendar, you are given a list of the fixtures on 
that date along with a prediction of the result.    If the result has already been entered 
then a  or a 

 is also shown according to the success or failure of the forecast.    The delta value 
upon which the forecast is based is also displayed.

Printing, saving and copying the forecasts

You can print the currently displayed forecasts, save them to a file or copy them to the 
clipboard by selecting the appropriate option from the menu bar or by clicking on the 
appropriate button on the toolbar.

Choosing another date and finishing

When you have finished looking at the forecasts you may select another date via the 
Another Date option or return to the top screen via the Finished option on the Options
menu.



The Goodies Menu

Five options are available under the Goodies menu option.

Team Search
Misdemeanors
Set Forecast Formula
Lucky Dip
Use Nicknames



Team Search

The Team Search option lets you find out which competition any chosen team is playing
in, in any of the seasons covered by the program.    All you have to do is enter a 
sequence of letters contained in the name of the team, and all the team names 
containing that sequence of letters will be displayed.    If you are using the Use 
Nicknames option then the team's nicknames are searched rather than their actual 
names.    The division the team is playing in also displayed.    It also lets you answer 
questions such as; name all the football league teams with the letter x in their name.



Misdemeanours

The Misdemeanours option is used when a team has done something naughty.    It is 
used to either deduct points from a team's league record, or disqualify a team 
altogether.    On disqualification it is assumed that all matches that the team has played 
become null and void.



Set Forecast Formula

The Set Forecast Formula option is used to define a formula for predicting results.    
Two forms of formula have proved successful.    The first is based on the number of 
results of each type that each team making up a fixture has had.    The second is based 
on the number of goals scored for and against by each team.    You choose which form 
of formula you want to use by clicking on the appropriate button.    In both cases there is
one formula for the home team and another one for the away team.    Each formula is 
evaluated and if they are close to one another, a draw is predicted.    Otherwise, the 
team with the highest total is selected as the winner.    The default formulae supplied 
with the program pit the home team's home form against the away team's away form.    
They both usually get about half their predictions correct.

On selecting this option, both formulas and the tolerance value are displayed.

The current formula value being edited is highlighted.    Use the numeric keypad and 
Enter key to enter numbers into the formula.    A new current value can also be selected 
by clicking on the appropriate slot with the mouse.    Whether a result type is included in 
the formula is controlled by the Used box next to each formula value.    A cross inside 
the box indicates that the value will be used.    Clicking on the box with the mouse 
toggles the usability.    The formulae are normalised by dividing by the number of games 
used and multiplying by 50.    A further restriction is given by the shelf life option.    This 
lets you limit the games used by the prediction formula to a given number of days 
before the date of the match.    If you do not want to use this restriction then enter a 
value of zero here and all the games played during the current season will be used.



At the start of the season there is no previous form to work on, so all matches will be 
predicted as draws.

As an example, consider the Forecast Formula shown in the Figure above, applied to 
the match between Leeds United and Blackburn Rovers on 15th April 1995.    At the time
of this match these teams had the following record:

So the Leeds United formula uses the results of their home games and gets 10x5 + 4x2 
+ 3x0 = 58 in 10 + 4 + 3 = 17 home games.    The Blackburn Rovers formula uses the 
results of their away games and gets 10x6 + 5x2 + 3x0 = 70 in 10 + 5 + 3 = 18 away 
games.    To compare the two formulae each number is divided by the number of games 
and multiplied by 50, so Leeds United get a total score of 58x50/17 = 170.6, while 
Blackburn Rovers get a total score of 70x50/18 = 194.4.    These two scores are within 
28 of each other so the teams are about equal and the match is predicted as a draw.

It is probably not possible to come up with a magic formula which always successfully 
predicts results, but you can have a lot of fun trying to find one.    Best of luck, and if you
find a good formula don't forget to let me know.



Use Nicknames

For a bit of fun you can use team nicknames rather than their real names on all the 
screens.    Just click on this menu option to toggle between using nicknames and real 
names.



TRACKING DOWN RESULTS

I have tried to make my program as easy to use as is possible.    I have provided all the 
fixture lists so you do not have to spend a lot of time tracking them down and entering 
them yourself.    However, there is still the problem of tracking down the results to feed 
into the program.

I get the results from the teletext pages on my television set.    Both CEEFAX, on BBC 
and TELETEXT on ITV, provide all the league and non-league results.    Usually all the 
results are displayed within minutes of the end of the game.    They also display the 
fixtures for the week ahead, so you can find any rearranged matches.    A disadvantage 
of getting results from teletext is that they are only displayed for less than a day before 
being replaced.    Another problem is the lack of hard copy.

If you do not have a teletext television set then newspapers provide an alternative 
source of results.    The quality daily newspapers, i.e. the Independent, the Telegraph 
and the Times usually give all the required results.    The Guardian and the tabloids are 
more unreliable, often missing midweek non-league results.    On Sundays, the 
Telegraph the Observer and the Mail on Sunday give the most comprehensive 
coverage.    They usually include both the results and the league tables for all the 
competitions covered by the program.    The published league tables can be compared 
against those produced by the program for consistency.    The other Sunday 
newspapers often provide a good coverage of League matches but only give results for 
the non-league matches without giving league tables.    There are also a number of 
excellent weekly football magazines, such as 90 Minutes, which supply all the required 
results along with lots of entertaining and informative articles.

If all these methods fail and you miss some crucial results then, if you have purchased 
the full version, for a nominal fee I provide an Update Service.    If you return your 
master disk to me along with a stamped self addressed envelope and two additional first
class stamps to cover administration charges.    I will provide you with the latest copy of 
the program containing all the results and send it back to you by return of post.



EXTRACT AND RESTORE PROGRAMS

Requirements

These programs require an IBM compatible computer, with an EGA or higher monitor 
and a mouse.

POOLS Expert Results Predictor

These programs let a pools prediction program called POOLS Expert Results Predictor 
have access to the Dr. Fox Football Annual data files.    This shareware program is 
available for £15 from either Dr. Fox or direct from the author Brian Campbell at Bay 
Computers, 3 Teasel Walk, Morecambe, Lancs. LA3 3QQ.    Telephone : 01524 - 
831162.    POOLS Expert Results Predictor is a program which analyses sequences of 
previous results to come up with predictions of future results.    It provides an alternative 
prediction method to those used by Dr Fox's Football Annual.

If anyone wants to use both Dr Fox's Football Annual and the POOLS Expert Results 
Predictor then they have to enter results and fixtures into both programs.    However, by 
using the EXTRACT and RESTORE programs, fixtures and results can be automatically
transferred between the programs, meaning that they only have to be entered manually 
once.    EXTRACT takes the fixtures stored in Dr. Fox's Football Annual and converts 
them into fixture lists for use by POOLS.    RESTORE uses the results file from Bay 
Computers POOLS Expert Results Predictor to update the results tables used by Dr 
Fox's Football Annual.    Therefore if you want to use both programs you should use the 
following procedure:

From within POOLS click on the Utils menu and select the Run Dr Fox Extract option 
to run the EXTRACT program to create a fixture list file for POOLS.    This is done by 
selecting the Find Fixtures option and then choosing the dates you want fixtures on.    
When you have finished exit from EXTRACT by choosing Finished from the Options 
menu, you will now be returned to POOLS.

You can now load the new fixture list into the POOLS program via the Load Fixtures 
option in the usual way.    Edit the fixture list, if necessary, and enter the results using 
Bay Computers POOLS Expert Results Predictor.    The results in Dr Fox's Football 
Annual will be automatically updated by POOLS, as it automatically runs the RESTORE
program after results are entered when you Quit from POOLS.

It should be noted that the DR-FOX program currently only copes with league matches, 
so only league fixture lists can be produced.    Cup fixtures still have to be entered 
manually, however this can easily be done by adding the cup fixtures to the league 
fixture list for the required date from within the POOLS Expert Results Predictor 
program.



WILL'S FOOTBALL YEARBOOK

The disk on the full version also comes with the fixtures in the format required for Will's 
Football Yearbook.    If you have purchased this program then install the fixture lists by 
issuing the command A:\YBFIX.    This will copy the fixture lists from the Dr Fox floppy 
disk into the appropriate directory on your hard drive.    Further details of Will's Football 
Yearbook can be obtained from Bill Hunter, Forth Dimension, 28 Macbeth Road, 
Dunfermline, Fife. Scotland KY11 4EG. Telephone 01383 - 721729.



COPYRIGHT OF PROGRAMS

Dr Fox's 1996 Football Annual is copyright.    Copyright © Dr. Fox 1997.    You should 
only copy it to make a back-up disk for your own use.    Dr Fox's Football Annual Demo, 
RESTORE and EXTRACT programs are Public Domain and may be copied freely.

POOLS Expert Results Predictor is a licensed shareware program.    If you use it a lot 
you should become a registered user by sending £15 to Bay Computers.    This entitles 
you to program support and discounts on upgrades.

Copyright    © Dr. Fox 1997
Dr. Fox, PO Box HP 54, Leeds. LS6 2XS



COPYRIGHT OF FIXTURE LISTS

The fixture lists used by this program are copyright.    You are not allowed to copy them 
without permission from the Football League.

FA Premiership Fixtures List Copyright © The FA Premier League Limited 1996, 
reproduced by Dr Fox's Football Annual under licence.

To use these fixture lists I have to pay the English Football League licence fees in 
excess of £1500 every season.    The reason I have to charge for copies of my football 
annual is to try and ensure that I recover this fee.



Lucky Dip

This simple utility uses a random number generator to choose selections for your 
football pools or National Lottery entries.    When using it to choose numbers for your 
pools coupon it allows you to exclude selected numbers so you can avoid those 
matches which you are confident will not produce a score draw.

To choose numbers to be avoided just click on the appropriate box next to the number 
you want to exclude. To delete the last exclusion use the delete key.

You can switch between Pools and Lottery mode via an option on the pull down menu 
bar.

Click on the OK box to generate your selection.



Frequently Asked Questions

1 There is no way to let users update the program for use next season.    Why?

This is because I want users to buy an updated version every season!    There are three 
reasons for this.

Firstly, it would take users quite a lot of effort to update the program themselves.    They 
would have to enter all the teams in each division, get hold of a copy of the fixture lists 
and then feed them into the program.    Typically it takes me about forty five minutes to 
an hour to do this for each division, giving a total time of about ten hours.    When you 
buy an updated version you are saving yourself all this effort.

Secondly, I like to add new features each season, so you get an even better program if 
you buy an updated version.    It is also impossible to ensure that the current version will
cope with any structural changes that might be made in future seasons.    For example 
when the Scottish League split up into three divisions with teams playing each other 
three or four times instead of the usual two times.

Thirdly, as mentioned in the section on copyright of fixture lists, I have to pay the 
English and Scottish Football Leagues licence fees in excess of £1500 every season in 
order to use their fixture lists.    So I need to sell quite a lot of copies of the program in 
order to recover these costs.    I try to price the program so that I just about break even.  
I also sell the program at a lower price to existing users who update the following 
season.

2 Who is Dr Fox?

My name is Ken Fox.    I have a PhD in Applied Mathematics from the University of 
London.    I am currently a Senior Research Fellow at the University of Leeds.    Dr. Fox's
Football Annual is just one of my hobbies.    My other hobbies include watching old 
movies with my wife, supporting Boston United, and feeding an increasing number of 
squirrels.    I am not Statto.

3 How good are the predictions?

As mentioned in the section on Setting the Forecast Formula, the program usually gets 
about half its predictions correct.

I have had letters from users who say that they regularly use the program to help them 
with fixed odds betting and that they manage to make a slight profit, but I have not tried 
this myself.

4 What about cup games?



I have been meaning to put in the capability of coping with cup games since I first 
started on the program on my Atari home computer in 1988.    But what with upgrading 
the current version and re-writing the code for PCs and then for Windows I have not 
quite managed to achieve it!    Maybe I will get round to putting something in this 
season.

5 Do you do a version for Australian or Italian or Norwegian football?

I do not do a version for the Australian pools, mainly because I do not know where to 
get hold of the required results and fixture lists.    I have produced versions for the Italian
Serie A and B and I once even produced a version for a Norwegian user to cover his 
own league.    I have produced a public domain version of the program for Atari 
computers which lets users set up their own leagues with up to eight divisions of up to 
twenty four teams.    If I get enough spare time I will convert this to a PC version this 
season.

6 What language is the program written in and can you supply me with the source 
code?

This Windows version of the program has been written using Microsoft Visual Basic, 
which must be the best product ever produced by Microsoft.    It took a lot of effort to 
write the program and I still have dreams of turning it into a fully fledged commercial 
product one day so I am hanging on to the source code for a bit longer. 



The Toolbar

On many pages there is also a toolbar, allowing common options to be selected using a 
single click with the mouse.    These include printing, saving to disk, copying to the 
clipboard, selecting another date, selecting another team and getting context sensitive 
help.




